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President’s Message
Catherine Magill, PhD

Back-to-School! Three words I was really looking forward to this year! 
It was nice having the two teenaged kids around for awhile, but it 

is really nice to have my house back so I can get some work done. 
I had a pretty quiet summer this year, and I hope that you all 
had a chance to get out and enjoy all that our glorious Northern 

California has to offer. We did a bit of camping and had a lovely long 
weekend houseboating on Shasta Lake with a big group of friends, and I 
enjoyed the summer weather that finally graced us into October.

Finally, I’d like to close with a mention that we have an exciting fall 
program that started with a chapter meeting on Sept 26th at Michael’s at 
Shoreline in Mt. View, where our very own Chapter Board Secretary Joan 
Brodovsky discussed Writing a Consulting Proposal. You can find the link 
to the online registration materials for future meetings on our website 
– www.amwancal.org

As usual, I will close with an encouragement to come to meetings 
whenever possible, we really try to keep the costs down and rotate them 
throughout the Bay Area so that you don’t always have to travel too far. I 
also encourage you to participate and volunteer - being active in AMWA 
allows you to contribute in a way that can enhance your career. We are 
also looking for people who are willing to participate on the Board in a 
variety of positions. It truly doesn’t take much time and in my experience 
is well worth every moment that I have spent on it, both professionally 
and personally. Don’t hesitate to contact me or any other Board member 
with questions or ideas of somehow you’d like to contribute.
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A Salute to Sunny
Most people who have been involved with AMWA know that 
finding people to serve as chapter officers is difficult. Members 
are overloaded with work, family, and other obligations and 
unwilling or unable to make a yearlong commitment, even 
though serving on the board takes at most a few hours a 
month. Sunny Bishop is a rare exception. 

Until her resignation in July, Sunny had been Treasurer of the 
Northern California chapter for 7 years. Even after she made 
the decision to leave the board, she postponed her resignation 
to ensure that the 2010 Pacific Coast (Asilomar) conference 
accounts were reconciled and that her replacement, CeeJay 
Holzhr, was up to speed. 

Living in the Sacramento area and taking care of a sick family 
member meant that Sunny wasn’t able to attend our chapter 
events; however, because she saw value in being involved with 
AMWA, she volunteered to serve on the board. Now Sunny is 
“moving on to greener pastures.” Since she has not been doing 
medical writing for some time, she has decided to put her 
volunteer efforts into an area that she is actively pursuing.

As treasurer, Sunny was an excellent, organized and prepared 
manager of the chapter finances. She was extremely thoughtful 
and reliable, and always had the chapter financial reports ready 
whenever we needed them or AMWA headquarters requested 
a copy. Said Program chair and Acting President Catherine 
Magill, “Unfortunately, I have never met her, although she 
participated in many teleconferences for Board activities. 
Although we’ve found an excellent replacement, whom Sunny 
has taken the time to train, I am very sad to see her go and 
hope that our paths cross again sometime very soon!”  

Sabotaged Bubblewrap!
Lou Lippman, Western Washington University

Preliminary intelligence indicates that a plastics plant in 
a remote country, where supervision is lax, has exported 
over 100,000 bolts of plastic packing materials to the United 
States since June 2004. This packing material consists of air-
filled plastic impact cushioning pockets often referred to as 
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“bubblewrap” or “bubble packing” by the general public.
Taking advantage of the lack of controls, suspected terrorists have 

contaminated the bubbles with either some type of biological agent 
(perhaps spores), or a gas that induces swelling and itching, red eye, and 
acute respiratory agitation. This form of red eye cannot be cured by even 
the most advanced digital cameras.

The terrorists involved in the manufacture of this product are well 
aware that Americans have an uncontrollable urge to manipulate the 
wrapping after use, popping the little bubbles. Hence, this is an excellent 
delivery mechanism for causing widespread and random exposure of 
the American public to harmful substances. Citizens should take care 
to keep the bubble-wrap intact when removing items from shipping 
cartons, and to keep it away from children, who have an especially 
difficult time resisting the urge to jump on it and pop the bubbles.

Pentagon spokesofficer Dr. Amy Silvester stated “These terrorists will 
stop at nothing to harm the American public.  The intelligence necessary 
to know that these materials would be sent to America suggests an 
organized, well-funded consortium of terrorists. This strange pursuit of 
harming the American public has not been seen since the height of the 
Cold War.”

Victims exposed to the harmful substances should immediately seek 
medical attention.

Copyright Journal of Irreproducible Results and Norman Sperling. All rights reserved.

Reproduced with full permissions, snickers, chortles, and guffaws. For more medical madness and 
pseudoscientific serendipity, go to http://jir.com/, where $26 will prove all theories with a single 
graph.

Secret Order
Sharon Kim

It’s always a challenge for a writer to get the audience to relate to a 
message. For those who make it their mission to communicate science 
and medicine, the task is much more daunting. Medical writers have to 
engage an audience without diluting the depth or breadth of research.

Bob Clyman makes an earnest attempt to do just that in his play “Secret 
Order,” which made its regional premiere at the San Jose Repertory 
Theatre in October under the direction of Chris Smith. 

In this “biomedical thriller,” Dr. William Shumway (James Wagner), a 
naïve researcher from the Midwest with a fresh perspective, believes 

that he “may have figured out how to cure cancer.” It doesn’t 
take long before his work grabs the attention of Robert Brock 
(Robert Krakovski), a Nobel Prize-minded, Big Pharma-friendly 
administrator at a major New York City research institute. 
Aggressive and unstoppable, Brock sweeps Shumway off his 
feet with promises of unlimited funding and resources – every 
young scientist’s dream. 

The young genius’ promising search for the cure is thwarted 
as his success threatens the establishment. One establishment 
representative is Saul Roth (Julian López-Morillas), an older 
researcher at the institute, who is on the verge of getting 
edged out into his retirement, which would free up additional 
resources for Shumway. The seemingly dormant yet surprisingly 
malignant Roth isn’t about to go down without a last fight. 

Meanwhile, perhaps pushed by the urgency of the 
predicament his research placed him into, Shumway chooses 
to make a compromise which ultimately contributes to his 
demise. The plot is further complicated when Shumway gets 
involved with, and confides in, a garrulous research assistant 
from Harvard, Alice Curiton (Kathryn Tkel). As Shumway gets 
sucked into producing results at all costs, Alice remains the 
sole voice of reason in his conscience.  

Clyman accomplishes making science palatable and 
entertaining by using several methods. First, he keeps it simple. 
He eases his audience into the science of cancer by using a 
layman’s language without going into too much detail. 

Second, the fictitious scientific concepts Clyman creates are 
plausible. He introduces a novel yet credible concept he named 
the “R cells” which makes the cancer “turn against itself.” 

Third, the writer works within familiar dramatic elements 
such as a missing father figure in Shumway’s childhood and 
the hint of a romantic attraction between Shumway and Alice. 
This shows the audience that yes scientists are human and 
as a result, the pursuit of science is subject to human flaws. 
Clyman’s script is very realistic and “rings true” without the 
myriad artifices or hyped hypotheses that plague most science 
or medicine-based scripts.
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Finally, he concludes the play with the suggestion that there is really 
no separation between science and human drama. Wherever there is 
human involvement, be it science or anything else, humans fail to resist 
projecting their own imperfections and selfish motivations onto it. The 
play ends up being both a tragedy of morals as well as an open-ended 
statement of ethics in a results-driven research environment.

Designing the Future of Cancer Research at the Koch Institute of 
MIT 
Catherine Magill, PhD

Speaker:  Robert Urban, PhD, Executive Director, The Koch Center for Integrative 
Cancer Research at MIT and Keynote Speaker at The AMWA Pacific Coast Conference, 
Asilomar, April 18, 2010

Dr. Robert Urban gave a riveting keynote lecture at this year’s Pacific Coast 
conference, held at the Asilomar Conference Grounds from April 18-21, 
2010. Dr. Urban discussed how the Koch Center for Integrative Cancer 
Research at MIT is approaching its goal of creating a highly collaborative 
environment where scientists and engineers work together to lengthen 
lives by controlling cancer. 

To set the stage for this discussion he gave an overview of the 
difficulties associated with the problem of cancer, in particular the 
projected growth of the number of cancer patients in the developing 
world. Then he gave a brief introduction to the biology of cancer and 
spent the rest of the time discussing how the Koch Center is set up to 
maximize the interactions between investigators, each using different 
approaches and all aimed at helping to discover drugs, treatments and 
diagnostics that will improve the treatment options for people who are 
diagnosed with cancer.  

MIT was selected as the site for The Koch Center for several reasons. One 
is the fact that cancer research falls in the top three institutional priorities 
of MIT, along with education and energy. MIT already has a world class 
reputation in cancer biology, with significant groundbreaking research 
having been done in the areas of oncogenes and tumor suppressors, 
and the identification of the molecular targets for the first approved 
targeted therapies against cancer, Herceptin and Gleevec.

The main thrust of the Koch Center is to provide a place that fosters 
integrated, interactive, multidisciplinary research between biologists 
and engineers. The approach is to drive first-rate cancer science, 

using top tier technology and scientists and engineers and 
encouraging the results to be greater than the sum of their 
parts. The aim is to hire 25 scientist and engineers into the 
new Koch Center who will be charged with looking outside 
the normal confines of their collaborative research into other 
disciplines, most notably engineering, thereby inventing 
new ways to look at problems and create cross-disciplinary 
solutions. These intramural scientists will be encouraged to 
collaborate widely with extramural researchers at MIT and 
other institutions and will be lead by a Leadership Council of 
Biotech, Clinical investigator and Advanced Science Center 
leaders. The Swanson Biotechnology Center actually resides 
within the Koch Center building, which will allow close and 
continuous interaction between their personnel.  

A specific aim is to maximize the use of genetically 
engineered mouse models of cancer to study developmental 
and pathway processes using genomic technology, advanced 
technologies such as high-end proteomic analyses and novel 
imaging methodologies, to create new drug classes that will 
be developed into novel therapeutic agents. A key to using the 
mouse models is to use “conditional” mutations that can be 
“turned on” to drive a cancer after the normal developmental 
process, within which they often participate, have ceased. 
They will use sophisticated analytical technologies such as 
micro computerized tomology equipment that can image 
the growth of tumor(s) in small animals. Obviously, all the 
most wonderful research in the world will not lead to rapid 
advancements in treatment options without the integrated 
involvement of clinician scientists, many of which have been 
recruited either in-house or through collaborations with 
existing clinical investigation programs.

The focus will be in five key areas of high impact research: 
nano, detection/monitoring, metastasis, pathways and 
immunology. In the area of nanotechnology work is being 
done at the Koch Center that aims to develop drug delivery 
methodology that will allow the direct delivery of drugs to 
tumors, thereby lowering toxicity and increasing the potency. 
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Very small, implantable sensors are also being developed, which contain 
a chemical accessible through a semi-permeable membrane, whose 
properties would change in the presence of tumor-derived marker;  this 
change being detectable with a handheld scanning device. Other types 
of diagnostics being investigated are fluorescent probes which bind to 
tumor cells thereby helping the surgeon determine whether the entire 
tumor has been excised by way of a handheld imaging device.  

Another area of great interest for the Koch Center is the area of tumor 
immunology and finding ways to harness the patient’s immune system 
to fight cancers. One of the immunological approaches that Dr Urban 
presented was using immune cells to target drug-tagged nanoparticles 
to prostate tumors, which gave a durable remission in a mouse prostate 
cancer model.

The Koch Center has already helped foster collaborations that have 
resulted in a variety of clinical trials being conducted at both the Dana-
Farber Cancer Inst and the Massachusetts General Hospital Cancer 
Center: gold nanorods in ovarian cancer and sarcoma treatment; 
nanotherapeutics for lung cancer; molecular characterization of colon 
metastasis to liver; controlled release of cisplatin in treatment of ovarian 
cancer; siRNA-mediated treatment of ovarian cancer and Novel Cancer 
Vaccine for Melanoma.

The focus of the Koch Center’s educational program is on teaching 
“team” science and encouraging inter-disciplinary projects. Collaboration 
is encouraged throughout MIT, between clinical centers, with the NIH/
NCI and other funders and with partners to aid in the translation of new 
discoveries into treatment options. 

If you are interested in finding out more about the Koch Center and the 
work that they are doing to improve the options for cancer patients, sign 
up for their free newsletter ”Cancer Solutions” at http://web.mit.edu/ki/
news/newsletter/index.html.

The Interactive Commands Finder in Word 2007 
Maggie Norris

This item shows the transitioning user how to find commands familiar from Word 2003. 

The next Word Witch seminar (details TBA) will be called “Ten Things we 
hate about Word 2007 And What We Can Do About It.” I encourage anyone 
with a pet peeve to tell me about it so we can discuss it during the seminar: 

Please email me at  Fine_Print_Services@mac.com. 
The most frequent complaint I’ve been hearing is the 

appearance of the document window. The Ribbon takes up 
too much screen space. The tabs are garish and distracting. 
Some users are even confessing that they miss old-fashioned 
pull-down menus. There are a few little adjustments we 
can make, but, for the most part, Word 2007 seems pretty 
inflexible.  

The next most-frequent complaint is that some of the 
commands writers are accustomed to using in their documents 
have disappeared. This one we can do more to solve. 

I’m grateful to a new friend, Bruce Hicks, a medical 
transcriptionist, for bringing an interesting feature of Word 
2007 to my attention. The Office Interactive Commands Finder 
can ease a multitude of complaints. 

First of all, reassurance: All commands from Word 2003 are 
available in Word 2007 (at least, all the ones writers are ever 
likely to use). Those of us who use keyboard commands much 
of the time are in luck. Any key command from 2003 also 
works in 2007.   

Procedure for Locating Commands in Word 2007 

Before you start, you must first install the Help files. Strangely, 
the default installation of Word 2007 does not include the Help 
files. In a previous item, we talked about how to download the 
Help files from the Word 2007 web site and install them in 
your copy of the application. After the installation is complete, 
there is a Help tab in the top-level tabs menu (Home, Insert, et 
cetera) at the top of the document window. (If you don’t see 
the Help tab, please drop us a note and we’ll send you your 
own personal copy of the How-To item.)

Find Commands 

Now we’re going to look at the tools on the Help ribbon 
that specifically assist you to find those missing Word 2003 
commands . 

Activate (click) the Help tab. Take some time to look at the tools 
(buttons) on the Help ribbon, just so you know what’s available. 
here 

•
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“Click Find Commands from Office 2003. The pull-down toolbar has two tools: 
Office 2003 Interactive Commands Finder and Office 2003 Command map. 
Click the Interactive Command Finder button. This calls up a replica of the 
Word 2003 document window. This tool is a nifty Flash screen built into the 
Help files. It is an interactive replica of the Word 2003 document window, 
with a functioning Main Menu. (It is functional, but does not function in the 
same way as in an actual Word 2003 document window.) 
Click an item on the Main Menu. The menu opens out, looking exactly as it 
does in Word 2003. 
Find information about the location of a command in Word 2007  

* Rest the pointer over a command on the submenu. A tip box pops 
up. 

* Alternatively, launch an animated demo showing how to locate the 
command: Click the submenu command. Return to your document, 
activate the tab, and click the command.  

Beyond the Basics

Now that you have located the command on its ribbon, are you going to 
remember where it is the next time you need it? Here are a few tips.

 If it’s something you use often, like Spelling & Grammar, memorize its 
location or use the key command (F7). 

Take some time to get familiar with the tab the command is on and the 
other commands on that tab. The designers of the Word 2007 interface 
put some time and effort into grouping commands logically. After a 
while, you’ll be thinking, “Track Changes. That’s probably on the Review 
tab,” and “Cross-references. I bet that’s on the References tab.”  

Add the command to the Quick Access toolbar. To get instructions for 
customizing the Quick Access toolbar: on the Help tab, click Quick Access 
to Commands.

Option To Switch Certificate Programs
Members in the Core, Science Fundamentals, or Advanced certificate 
programs will still be able to complete those certificates within their 
enrollment timeframe. Workshops are being offered with multiple 
designations to accommodate all certificate programs. However, if you 
wish to change from Core or Science Fundamentals to the new Essential 
Skills certificate or a specialty certificate such as Concepts in Science 
and Medicine, you can do so at no additional fee. Contact Dane Russo at 
AMWA headquarters (dane@amwa.org). 

•

•

•

•

Like What You See? Want to Make it Better? 
The Pacemaker, our Northern California chapter newsletter, is 
your publication. We need your help, your opinons, and your 
contributions!  Send your suggestions and submissions to 
Pacemaker editor Fred Gebhart, pacemaker@amwancal.org. 

2010 Northern California Board of Directors

Acting President Catherine Magill president @ 
amwancal.org

Vice President vacant president @ 
amwancal.org

Programs Chair Catherine Magill programs @
amwancal.org

Treasurer Ceejay Holzhr treasurer @
amwancal.org

Secretary Joan Brodovsky secretary @
amwancal.org

PCC Conference 
Chair

Kristen Mayo conference @ 
amwancal.org

Newsletter Editor Fred Gebhart pacemaker @
amwancal.org

Membership 
Liasion

Mimi Wessling membership @
amwancal.org

Web Administrator Mimi Wessling webmaster @
amwancal.org

10

mailto:president@amwancal.org
mailto:president@amwancal.org
mailto:president@amwancal.org
mailto:president@amwancal.org
mailto:programs@amwancal.org
mailto:programs@amwancal.org
mailto:treasurer@amwancal.org
mailto:treasurer@amwancal.org
mailto:secretary@amwancal.org
mailto:secretary@amwancal.org
mailto:conference@amwancal.org
mailto:conference@amwancal.org
mailto:pacemaker@amwancal.org
mailto:pacemaker@amwancal.org
mailto:membership@amwancal.org
mailto:membership@amwancal.org
mailto:webmaster@amwancal.org
mailto:webmaster@amwancal.org

